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Welcome

This guide is an introduction to Pentaho Business Analytics, and includes:

• Instructions for the installation of Pentaho Business Analytics on Windows
• Features of a simple report created using Pentaho Interactive Reporting
• Features of a simple report created using Pentaho Analyzer
• Features within a report created within the Pentaho Dashboard Designer
• Creating a data source
• Creating a new analyzer report
• Working with dashboards
• An appendix with instructions for accessing other client tools
• An appendix with a list of supported and compatible products
• An appendix with instructions for troubleshooting your installation

Important:  If you need further information deploying Pentaho Business Analytics or have custom configuration
requirements, contact your Pentaho Sales Representative or send an email to Support.

mailto:supportadmin@pentaho.com
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Overview

This section contains information about the Pentaho components included in this release and system requirements for
installation.

Components Included in this Release
There are three categories for the components of this release: content creation tools, solution design tools, and service
providers (servers). The three categories and their contents are:

Thin Client Tools

• Interactive Reporting
• Analyzer
• Dashboard Designer

Design Tools

• Schema Workbench
• Aggregation Designer
• Metadata Editor
• Report Designer
• Data Integration
• Design Studio

Server Applications

• Enterprise Server
• BA Server
• DI Server

Below please find a graphical representation of the components of this release.
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Thin Client Tools

The Pentaho User Console is a web-based user interface that is used to view, create, schedule, and apply permissions
to reports and dashboards. The Thin Client Tools all run within the Pentaho User Console in a browser (such as Firefox,
Chrome, or Internet Explorer).

Design tool Description

Pentaho Interactive Reporting Pentaho Interactive Reporting is a web-based design
interface which is used to create both simple and ad hoc
operational reports, without depending on IT or report
developers.

Features include the ability to:

• Access Pentaho Metadata data sources
• Easily interact with reports
• Use a drag-and-drop designer to add, move, and

delete fields within the report canvas
• Use inline formatting, filtering, sorting, grouping,

aggregations, and summary calculations
• Design and edit reports with WYSIWYG (What You

See Is What You Get) software
• Create reports based on templates

Pentaho Analyzer Pentaho Analyzer is an intuitive analytical visualization
tool that filters and drills down into business information
contained in Pentaho Analysis data sources.

Features include:

• Accessibility to Pentaho Analysis data sources
• Web-based, drag-and-drop report creation
• Advanced sorting and filtering
• Customized totals and user-defined calculations
• Chart visualizations

Pentaho Dashboard Designer Dashboard Designer allows users to create dashboards
with little or no training. The dashboard is several different
reports brought together inside one screen.

Features include the ability to:

• Create dashboards by selecting the layout, theme, and
content you want to display.

• Include any type of Pentaho reports, external web
pages, or dashboard internal elements (charts and
data grid) that access Pentaho Metadata data sources.

• Add dynamic filter controls
• Drive content within a dashboard using other

dashboard content

Design Tools

The design tools are desktop applications that allow you to create BI solutions for reporting and analysis:

Design tool Description

Report Designer Report Designer is a visual design environment that
makes it easy for report authors to quickly create
sophisticated reports. These reports can encompass a
wide range of data sources that address the demands of
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Design tool Description

operational, financial, and production reporting. They can
also be executed as standalone reports within the User
Console or used within a Pentaho Dashboard. In addition,
Report Designer creates detailed charts, and templates
for Pentaho Interactive Reporting and Report Design
Wizard. It is best used by experienced users who are
familiar with report design concepts and the data sources
used.

Pentaho Data Integration Data Integration is an intuitive, graphical, drag-and-drop
design environment that provides powerful Extraction,
Transformation and Loading (ETL) features. In addition,
Pentaho Data Integration provides you with Agile BI
capabilities that collapse the multi-step and lengthy
BI project cycles into a single integrated design,
modeling, and visualization process. Agile BI drives close
collaboration between BI application developers and end-
users.

Pentaho Metadata Editor Metadata Editor builds Pentaho metadata data sources, a
data model representation of a relational database where
business users can create queries without having to
know SQL. Pentaho Dashboards and Pentaho Interactive
Reporting are primary tools to access this data source.
Additionally, a data model designer can tag useful
attributes to secure or format columns in a data model
which can be inherited in a report (prpt) and interactive
report (prpti).

Pentaho Schema Workbench Schema Workbench builds Pentaho Analysis data
sources, (ROLAP cubes) facilitating data exploration and
analysis for business users without having to know MDX.

Pentaho Aggregation Designer Pentaho Aggregation Designer is a graphical environment
used to increase query performance of a Pentaho
Analysis (Mondrian OLAP) schema through the creation
of aggregate tables.

Pentaho Design Studio Design Studio is used to create Action Sequences
(.xaction). Action Sequences define lightweight, success-
oriented process flows within the Pentaho Business
Analytics Server. It enables full customization and
integration among all components within Pentaho
Business Analytics.

Server Applications

The Business Analytics Server (BA Server) is a Java-based report management system, application server, and
lightweight process-flow engine. The BA Server also provides a Web-based interface for creating, scheduling, and
distributing reporting, analysis, and dashboard content.

The Data Integration Server (DI Server) is a dedicated enterprise class server for ETL and Data Integration. It is
used to execute Data Integration jobs and transformation. It also provides services such as scheduling and content
management (including revision history and security integration).

The Enterprise Console Server provides security, scheduling, repository management, and configuration services for
the BA Server and DI Server.

System Requirements
This section lists system requirements for Pentaho Business Analytics.
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Pentaho provides several installation paths to meet a variety of customer needs. This procedure is the simplest, but
provides the least customization. This guide explains how to use the graphical installer to perform a default installation
of the latest release of the Pentaho Business Analytics Enterprise Edition.

Note:  There are 32-bit and 64-bit editions of this installation utility. Check the file name to ensure that you are
using the intended version before you proceed.

The Pentaho Business Analytics
Installation Utility Will Provide

You Must Supply On Your Own

Application server: Tomcat 6.0

Solution database: MySQL 5.0

BA Server:

• Pentaho User Console
• Analyzer
• Dashboard Designer
• Interactive Reporting
• Pentaho Enterprise Console

Data preparation tools:

• Schema Workbench
• Pentaho Data Integration
• Metadata Editor

Design tools:

• Report Designer
• Design Studio
• Aggregation Designer

Data Integration (DI) Server

Hadoop support for PDI

Hive support for Pentaho Metadata

A Sun JRE 1.6.0 on the server, and on each workstation
that you will install data preparation or design tools to

Steel Wheels sample data

A supported operating system:

(See Compatibility Matrix: List of Supported Products on
page 35 for detailed OS, database, and application
server version information.)

• Linux
• Windows
• OS X

You may also provide your own data source if you
wish. It must be in one of the following formats:

• Any JDBC-compliant database
• A spreadsheet
• A flat file containing comma-separated values

Note:  The graphical installation procedure is most popular for pre-sales evaluation; the manual deployment
process is most popular for development and production installations.

Hardware Requirements

Pentaho Business Analytics does not have strict limits on computer or network hardware. As long as you meet the
minimum software requirements (note that your operating system will have its own minimum hardware requirements),
Pentaho is hardware agnostic but there is a recommended set of minimum system specifications:

Server:

• RAM: at least 4GB
• Hard drive space: at least 2GB for the software, and more for solution and content files
• Processor: dual-core AMD64 or Intel EM64T

Workstation:

• RAM: at least 2GB
• Hard drive space: at least 1GB for the software, and more for solution and content files
• Processor: dual-core AMD64 or Intel EM64T

It's possible to use less capable machines, but in most scenarios this will result in an undesirable level of performance.
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Your environment does not have to be 64-bit, even if your processor architecture supports it. All modern desktop,
workstation, and server machines have 64-bit processors, but they sometimes ship by default with 32-bit operating
systems. Please check with your Information Technology Department if you are unsure of your configuration. If you
want to run Pentaho Business Analytics in a pure 64-bit environment, you will have to install a 64-bit operating system,
ensure that your solution database and Java Runtime Environment are 64-bit, and install Pentaho Business Analytics
via the 64-bit graphical installer, or through the archive-based or manual deployment methods.

Note:  A 32-bit JRE has a hard memory limit of 2GB (1.5GB on Windows), so if you have 2GB or more of
RAM, you must use a 64-bit JRE on a 64-bit operating system to take full advantage of it. This means that,
through architectural limitations, a 32-bit environment will likely be under-powered for a production BA Server
deployment.
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Installing Pentaho Business Analytics

These instructions assume that you have used graphical installer and incorporated the default settings, which installs to
a local device (localhost).

If you are upgrading, ensure that all previous versions of Pentaho software have been removed from your
machine. If you do not delete previous versions, there is an increased possibility for errors.

Follow the instructions below as you go through each step in the installation wizard. See Troubleshooting Your
Installation on page 40 in the unlikely event you run into port conflict issues.

Note:  You must disable any anti-spyware software before installing Pentaho Business Analytics. Some types of
software firewalls and anti-virus scanners may also block the BA Server or prevent it from operating normally.

1. Click Next in the Welcome page.

2. Read and accept the License Agreement.

3. Click Default to accept the default installation.

4. Specify the location to install Pentaho Business Analytics.

Note:  You must have the ability to write to the installation directory from your user account. If you attempt to
install to a write-protected directory, you will encounter various problems with your installation.

5. Type and retype password to set the master password for required users, the repository "root" user, the BA server
publish password, and the admin user for the Pentaho Enterprise console.

Obviously this is not very secure. However, this installation and the instructions in this document are intended for
evaluation purposes only. Production installations require more careful consideration and have a separate set of
guides intended for system administrators. The examples in this document assume that you will use password
as your global Pentaho password. If you choose a different password, adjust the instructions later in this guide
accordingly.

6. Click Next to start installing the Pentaho components.

7. Once the installation is complete, you can choose to view the installation summary and launch the Pentaho User
Console. Accept the default choices.
This document and Pentaho User Console home page will appear. Some systems may prevent the browser from
opening. In these instances, you must open a browser and navigate to the console manually. See instructions for
starting the Pentaho User and Pentaho Enterprise consoles under Verifying Your Installation on page 40. Keep
your console open and available as you step through the exercises in this document.

Logging into the Pentaho User Console
Below are instructions for logging into the Pentaho User Console.

Note:  The Pentaho User Console opens automatically after installation. If you do not currently have it open,
follow the first step below to open it.
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1. Go to Start -> All Programs -> Pentaho Enterprise Edition  ->  User Console Login, or open a browser and go to
http://localhost:8080/ or or the hostname, IP address, or domain name of the machine you installed the BA
Server to.

Note:  The BA Server must be on or you will receive an error screen once you log in.

2. Enter the User Name joe and the password password (all lowercase letters), to open the Pentaho User Console
launch page. Joe is a sample user with administrative privileges to the Pentaho User Console.

The Pentaho User Console launch page will appear.

Starting and Stopping the Servers
To start or stop any of the servers in Pentaho Business Analytics, go to Start -> All Programs -> Pentaho Enterprise
Edition -> Server Management. Select the server you want to start or stop.
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Examining Sample Reports

The Pentaho Business Analytics download includes sample data called Steel Wheels. Steel Wheels is included so that
you can quickly use the software and discover Pentaho Business Analytics' capabilities.

This section will give you step-by-step instructions for analyzing three different reports. Each report was created with a
different thin client tool. These reports are named:

• Inventory List Report, created with Pentaho Interactive Reporting
• Top Five Product Lines by Territory, created with Pentaho Analyzer
• Regional Sales Performance Dashboard, created with Pentaho Dashboard Designer

If you would like another functionality or different type of report included please let us know so we can try to include it in
future releases.

Inventory List Report
This section explains how to find, open, and generate an Inventory List report, which highlights many Report
Designer capabilities.

How To Find This Report In The Pentaho User Console

This report was created using Report Designer and published to the BA Server; you can find it in the Pentaho User
Console solution repository by following these steps:

1. Click on the Open File icon.
2. The Open box will appear.
3. Within this box, open Steel Wheels.
4. Open the Reporting folder icon.
5. Open the Inventory List icon.

How to Open the Source Report in Report Designer

When published to the BA Server, you can only run, schedule, and share a report. To edit the style or structure of a
report, you must edit it in Report Designer.

1. Go to the Start menu.
2. Select All Programs.
3. Open Pentaho Enterprise Edition.
4. Open Design Tools.
5. Open Report Designer. The Welcome page will open.
6. Within the Welcome  page, inside of the right side inner Samples window, open Inventory List.

How to Generate a Report in Report Designer

You can generate reports manually from Report Designer. This is useful for testing, and for creating reports locally that
don't need to be shared with Pentaho User Console users.

1. Click on the Run button ( green right-facing arrow) within the top tool bar. A drop-down menu will appear with
possible formats.

2. Select the format for your report.
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Featured Report Designer Capabilities

The below graphic shows how Inventory List implements some Report Designer features.

1. Mixing of columnar and form style layouts
2. Produce data-driven hyperlinks to access external content or launch other Pentaho reports
3. Conditionally color elements by setting the background color based on a formula expression
4. Control when elements (name, cost, etc.) display on a report, based on report parameters
5. Elements can have dynamically set width and position
6. Ability to hide repeating rows
7. Generate sophisticated bar codes for all major symbologies (for example: EAN, UPC, ISBN, EAN13, Code39,

Code128, UPCE)

Some other features not shown in the above image:

• Pick from an assortment of selection controls (buttons, drop-down list boxes, list boxes, checkboxes, options) to
pass values to report parameters and drive report data.

• Fine-tune the presentation of report sections (Table of Contents) or elements based on the output type.
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Top Five Product Lines by Territory
This section explains how to find, open, and generate a Product Line Report. It also highlights some popular Pentaho
Analyzer capabilities that are available within this product line report, Top 5 Product Lines by Territory.

How To Find and Open This Report

This report was created using Penatho Analyzer; you can find it in the Pentaho User Console solution repository by
following these steps:

1. Click on the Open File icon.
2. The Open box will appear.
3. Within this box, open Steel Wheels.
4. Open the Analysis folder icon.
5. Open the Top 5 Product Lines by Territory icon.

Pentaho Analyzer Panels

The below graphic shows the different panels within the Top 5 Product Lines by Territory while being viewed in the
Pentaho User Console. Each of these elements allow the report to implement Pentaho Analyzer features.

Table Formatting Using the Available Fields Panel and the Layout Panel

The new Layout Panel allows you to easily drag levels and measures into the correct areas of your report.
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1. Yellow steps represent levels within the hierarchy, clearly marking these as levels (text fields).
2. Blue carpenter squares represent measurements within the hierarchy, clearly marking these as measures (number

fields).

Dynamically Changing the Layout

You have the ability to dynamically change the layout of your chart. You can:

• Drag measures into the Measures field in the Layout column to add them to your chart.
• Drag levels into the Rows and Columns field in the Layout column to add them to your chart.
• Delete a field by dragging it to the bottom right corner of the page. A trash can will appear and you can "throw away"

the field you don't want. It will remain in the Available Fields panel but it will be deleted from the Layout Panel.

Layout Panel Field Customization

With the new Layout Panel, you can see which fields are available for report creation. The fields change depending on
the type of report you want to create.
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Chart Types

There are 12 types of charts in addition to the Table Format. These are:

• Column
• Stacked Column
• 100% Stacked Column
• Bar
• Stacked Bar
• 100% Stacked Bar
• Line
• Pie
• Area
• Scatter (new for Version 4.5)
• Geo Map (new for Version 4.5)
• Heat Grid (new for Version 4.5)

A check mark will appear to the left of the currently selected chart type.

Featured Pentaho Analyzer Capabilities

The below graphic shows how the report implements some Pentaho Analyzer features within the Pentaho User
Console.
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The Top 5 Product Lines by Territory report features the ability to:

1. Ability to simply subtotal items for a dimension.
2. Additional location where you can add filters (alternative to the new Layout Panel).
3. Quickly visualize and compare values using the Data Bar.
4. Add colored-range bar to easily determine outliers and median values.

Other Abilities Not Shown Above

• Drill on a data cell to view supporting data.
• Leverage Pentaho Analysis for fast Top/Bottom queries.

Regional Sales Performance Dashboard
This section explains how to use a customized dashboard. The dashboard pulls in previously created reports into one
place for presentation purposes. You will use the sample file Regional Sales Performance, which shows a dashboard
that contains three filters, two charts, (created using Chart Designer — Sales Mix and Recent Sales), and an Analyzer
report (Product Performance). Pentaho Dashboard Designer features an interactive drag-and-drop interface that
allows you to quickly assemble content, as well as link to content both within and outside of the dashboard.

How To Find and Open This Report

This report was created using Pentaho Dashboard Designer. You can find it in the Pentaho User Console solution
repository by following these steps:

1. Click on the Open File icon.
2. The Open box will appear.
3. Within this box, open Steel Wheels.
4. Open the Dashboards folder icon.
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5. Open the Regional Sales Performance file.

Featured Report Designer Capabilities

The below graphic shows how the Regional Sales Performance implements popular Dashboard Designer features.

Regional Sales Performance dashboard features:

1. Pick from an assortment of selection controls (buttons, drop down list boxes, list boxes, checkboxes, options) to
pass parameters to any dashboard panel.

2. Build flash-based charts (bar, line, pie, area, dial) that are interactive with the dashboard.
3. Display any Pentaho-generated content.
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Creating a Data Source

The Data Sources feature allows you to connect to your data so that the data can be used to create reports, (such as
Interactive Reports, Analyzer Reports, and Dashboards), in the Pentaho User Console.

Using the Data Source Wizard, you can quickly add, edit, and delete CSV File, SQL Query, and Database Table(s)
data sources in the Pentaho User Console.

Below is a quick description of each data source type:

Data Source Type Description

CSV File Data originating in a CSV file is extracted and staged in
a database table on the Pentaho BA Server. A default
Pentaho Metadata (Reporting) Model and a Mondrian
(OLAP) Schema are generated for use in Interactive
Report, Dashboard, and Analyzer.

SQL Query A SQL query written against a relational database is used
to establish the context of the data source. Data available
for report creation is confined to the scope of the data
source’s query. A default Pentaho Metadata (Reporting)
Model and a Mondrian (OLAP) Schema are generated for
use in Interactive Report, Dashboard, and Analyzer.

Database Table(s) Reporting Only Data originates in a one or more relational database
tables that is often operational or transactional in nature.
Using the Data Source Wizard, database tables can
be selected and joined. A default Pentaho Metadata
(Reporting) Model is generated for use in Interactive
Report and Dashboards only.

Database Table(s) Reporting and Analysis Data originates in one or more relational database tables
arranged in a star schema with a single fact table. Using
the Data Source Wizard, multiple dimension tables can
be selected and joined to the single fact table. A single
table containing both fact and dimensional information can
also be used for this data source type. A default Pentaho
Metadata (Reporting) Model and a Mondrian (OLAP)
Schema are generated for use in Interactive Report,
Dashboard, and Analyzer.

The exercises in this section will walk you through creating a Database Table(s) Reporting and Analysis data source.

Adding a JDBC Driver
Before you can connect to a data source in any Pentaho server or client tool, you must first install the appropriate
database driver. Your database administrator, CIO, or IT manager should be able to provide you with the proper driver
JAR. If not, you can download a JDBC driver JAR file from your database vendor or driver developer's Web site. Once
you have the JAR, follow the instructions below to copy it to the driver directories for all of the Business Analytics
components that need to connect to this data source.

Note:  Microsoft SQL Server users frequently use an alternative, non-vendor-supported driver called JTDS. If
you are adding an MSSQL data source, ensure that you are installing the correct driver.

Backing up old drivers

You must also ensure that there are no other versions of the same vendor's JDBC driver installed in these directories.
If there are, you may have to back them up and remove them to avoid confusion and potential class loading problems.
This is of particular concern when you are installing a driver JAR for a data source that is the same database type
as your Pentaho solution repository. If you have any doubts as to how to proceed, contact your Pentaho support
representative for guidance.
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Installing JDBC drivers

Copy the driver JAR file to the following directories, depending on which servers and client tools you are using
(Dashboard Designer, ad hoc reporting, and Analyzer are all part of the BA Server):

Note:  For the DI Server: before copying a new JDBC driver, ensure that there is not a different version of the
same JAR in the destination directory. If there is, you must remove the old JAR to avoid version conflicts.

• BA Server: /pentaho/server/biserver-ee/tomcat/lib/
• Enterprise Console: /pentaho/server/enterprise-console/jdbc/
• Data Integration Server: /pentaho/server/data-integration-server/tomcat/webapps/pentaho-di/

WEB-INF/lib/

• Data Integration client: /pentaho/design-tools/data-integration/libext/JDBC/
• Report Designer: /pentaho/design-tools/report-designer/lib/jdbc/
• Schema Workbench: /pentaho/design-tools/schema-workbench/drivers/
• Aggregation Designer: /pentaho/design-tools/agg-designer/drivers/
• Metadata Editor: /pentaho/design-tools/metadata-editor/libext/JDBC/

Note:  To establish a data source in the Pentaho Enterprise Console, you must install the driver in both the
Enterprise Console and the BA Server or Data Integration Server. If you are just adding a data source through
the Pentaho User Console, you do not need to install the driver to Enterprise Console.

Restarting

Once the driver JAR is in place, you must restart the server or client tool that you added it to.

Connecting to a Microsoft SQL Server using Integrated or Windows Authentication

The JDBC driver supports Type 2 integrated authentication on Windows operating systems through the
integratedSecurity connection string property. To use integrated authentication, copy the sqljdbc_auth.dll file to all
the directories to which you copied the JDBC files.

The sqljdbc_auth.dll files are installed in the following location:

<installation directory>\sqljdbc_<version>\<language>\auth\

Note:  Use the sqljdbc_auth.dll file, in the x86 folder, if you are running a 32-bit Java Virtual Machine (JVM)
even if the operating system is version x64. Use the sqljdbc_auth.dll file in the x64 folder, if you are running a
64-bit JVM on a x64 processor. Use the sqljdbc_auth.dll file in the IA64 folder, you are running a 64-bit JVM on
an Itanium processor.

Connecting to Your Database
To create a Database Tables data source, you must first connect to the database that contains data you want to
access, (if a database connection does not already exist). Existing database connections appear in a list under
Connection in the Data Source Wizard.

Note:  A default connection is provided for evaluation purposes, but these steps for connecting to the sample
data have been included for evaluating the data

Follow the instructions below to connect to a database:

1. In the Pentaho User Console quick launch page click Create New as shown in the below image.
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2. Under Data Source Name, type Orders Report and Analysis KT.

3. Under Source Type, select Database Table(s) as your data source type.

4. In the lower portion of the wizard page, under Create data source for select the radial button for Reporting and
Analysis (Requires Star Schema).

5. In the center of the page, to the right of Connection:, click the Add icon (the green circle with a white plus sign
inside of it) to define a connection to the database. The Database Connection dialog box appears.

6. In the Connection Name text box, type SampleData. A Connection Name must be easy to remember and must
identify the data you are accessing. The name can have spaces but it cannot have special characters (#, $, %, etc.).

7. Under Database Type, select Hypersonic.

Text fields for required settings associated with your connection type appear under Settings on the right.

8. Enter the appropriate connection information for your database type:

Option Description

Host Name localhost

Database Name sampledata

Port Number 9001 (automatically available, by default)
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Option Description

User Name pentaho_user

Password password

9. In the Database Connection dialog box, click Test to test your connection and click OK.
A success message appears. The connection name appears in the list under Connections in the Data Source
Wizard.

Creating a Database Table(s) Data Source (Reporting and Analysis)
Before proceeding make sure that you have selected the SampleData connection and that Reporting and Analysis
(Requires Star Schema) option is enabled.

These steps will show you how to set up the connection between Pentaho Data Source software and your database.
This connection is called a datasource. The Pentaho Data Source not only creates the path between the software
and the database, it also adds Metadata (names within the software) to create a user-friendly definition for the content.
We will be using sample data to connect the fact table ORDERFACT with the dimension tables CUSTOMER_W_TER,
DIM_TIME, and PRODUCTS within the database.

1. In the Data Source Wizard, click Next.
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A list of available database tables appears.

2. Press <CTRL+CLICK> to select the ORDERFACT, CUSTOMER_W_TER, DIM_TIME, and PRODUCTS tables,
then click the right-facing green arrow between the fields to move the selections to the Selected Tables field.

3. Under Fact Table, at the bottom of the window, select ORDERFACT and click Next.

Note:  The Fact Table must be selected before you can proceed. In a production environment, a database
administrator knows how to identify Fact tables.

4. You must define how the tables you selected join to each other. Your fact table (in the left drop-down field) must
link to all of your dimension tables (the tables in the right drop-down field). Ensure that "PUBLIC".ORDERFACT is
selected in the Left Table: drop-down menu. "PUBLIC".ORDERFACT will be the selection for all of the preceding
steps.

a) Select "PUBLIC".CUSTOMER_W_TER in the Right Table: drop-down menu. Select the CUSTOMERNUMBER
table from both the left and right lists. Click the Create Join button in the middle right side of the window.
The join relationship between "PUBLIC".CUSTOMER_W_TER (Dimension Table) and "PUBLIC".ORDERFACT
(Fact Table) is created. Both tables share the key field, CUSTOMERNUMBER. The Join(s): screen at the bottom
of the page will populate with:

"PUBLIC".ORDERFACT.CUSTOMERNUMBER - INNER JOIN -
"PUBLIC".CUSTOMER_W_TER.CUSTOMERNUMBER

b) Select "PUBLIC".DIM_TIME in the Right Table: drop-down menu. Select the TIME_ID field from both the left
and right lists. Click the Create Join button in the middle right side of the window.
The join relationship between "PUBLIC".DIM_TIME (Dimension Table) and "PUBLIC".ORDERFACT (Fact
Table) is created. Both tables share the key field, TIME_ID. The Join(s): screen at the bottom of the page will
populate with:

"PUBLIC".ORDERFACT.TIME_ID - INNER JOIN - "PUBLIC".DIM_TIME.TIME_ID
c) Select "PUBLIC".PRODUCTS from the list under Right Table: drop-down menu. Select the PRODUCTCODE

field from both the left and right lists. Click the Create Join button in the middle right side of the window.
The join relationship between the "PUBLIC".PRODUCTS table and "PUBLIC".ORDERFACT table is created.
Both tables share the key field, PRODUCTCODE. The Join(s): screen at the bottom of the page will populate
with:

"PUBLIC".ORDERFACT.PRODUCTCODE - INNERJOIN - "PUBLIC".PRODUCTS.PRODUCTCODE
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5. Click Finish to create your data source.

6. In the Data Source Created dialog box, select the bottom Customize model now radial button. Click the OK
button.

7. When the next window appears, click the OK button to close it.

At this time, the new data source is added to the list of available data sources that users select when creating a new
Interactive Report, a dashboard, or Analyzer report.

Customizing the Data Source
During the data source creation process, a default Pentaho Metadata (Reporting) model and a Mondrian (OLAP)
Schema (model) are generated. You may want to make changes to the default model so that the data is more useful to
report consumers but the default model can be used as is.

You can edit your data source by clicking the Manage Existing button within the Pentaho User Console launch page,
selecting the appropriate data source, then clicking the Close button. You may now create a New Report, a New
Analysis, or a New Dashboard based upon the database tables you have just linked. For more information about
customizing your data source, see Customizing a Reporting Data Source and Customizing an Analysis Data Source in
the Pentaho User Console Guide.
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Creating a New Analyzer Report

Follow the instructions below to create an Analyzer report with the Steel Wheels sample data.

Note:  Notice that the yellow steps denote levels in a hierarchy and the blue carpenters squares represent
measures. Level elements must be placed in the Level panels and Measure elements must be placed in the
Measure panels.

1. In the Pentaho User Console menubar, go to File -> New and select Analyzer Report.
The Pentaho Analyzer design tool will start.

2. Select the Steel Wheels: SteelWheelsSales option from the list, then click OK.
A blank Analyzer report appears.

3. Click and drag the Territory element, dropping it into the Rows Panel. Click and drag the Sales element into the
Measures Panel.

A table with the Territory and Sales appears and auto-populates with the information from the server.

4. Click and drag the Years field, dropping it into the Columns Panel.
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The Years columns are added to the existing table. They also auto-populate with the information from the server.

5. Click and drag the Line field and drop it next to Territory.
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6. Right-click the Line column and select Show Subtotals.

7. Right-click the first Sales column and select Conditional Formatting -> Data Bar - Green.

8. Right-click the same (first) Sales column and select User Defined Measure -> % of Rank, Running Sum.., then in
the dialog box select % of Sales. Click Next.
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9. Select the radial button for Each Line Column/Row Subtotal (Subtotal is 100%). Click Done.

10.Click and drag the Territory field (under Available Fields on the left) into the filter area at the top of the report.

11.In the Filter on Territory dialog box, select APAC from the list and click the top, right-pointing green arrow to move
it to the box on the right.

12.Enable Parameter Name by clicking on the check box in the bottom left of the dialog box. Type region (lowercase)
as your parameter name in the text box. Click OK.

The report updates and displays sales data for APAC exclusively.

Click the line that separates each column to adjust it for better viewing. Move the line right or left as needed.
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13.At this point you have a functioning report which can be viewed in a chart format. Click the Switch to Chart Format
button (or select CNTRL + ALT + C) to examine your report data in a chart format. The default display is a bar chart
but if you click the down arrow to the right of the Switch to Chart Format button, you can select a different format.

14.Save your report before continuing the exercise. In the Pentaho User Console, click the Save As button. When the
Save As dialog box appears, save your report as Territory Line - Sales under /Steel Wheels/Analysis and
click Save.

You've successfully created an Analyzer report from scratch.
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Working with Dashboards

Dashboards provide at-a-glance access to key performance indicators for your business. Pentaho Dashboard Designer
makes it easy to create dashboards based on existing BI content. Dashboard Designer also makes it easy to generate
simple charts and data tables within the tool.

Defining Your Dashboard Look-and-Feel
Ensure that you are logged on to the Pentaho User Console. Follow the instructions below to create a new dashboard.

1. In the Pentaho User Console Launch page, click New Dashboard. Alternatively, go to File > New > Dashboard in
the Pentaho User Console Launch page or click New Dashboard in the toolbar.

2. In the edit pane (lower portion of the page), click Properties, and type My Dashboard in the Page Title text box.
This is the title for your dashboard page.

The name you entered appears on the top left corner of the dashboard.

3. Click Templates and select the 2 Column layout to use for this exercise.

4. Click Theme, and select the theme of your choice.
The new theme will be applied to your dashboard immediately.

Adding Data to Your Dashboard
Follow the instructions below to add data to your dashboard.

1. Open a new Dashboard report.

2. Open the samples repository (Steel Wheels) and open the Reporting folder to display the list of available reports.

3. Click-and-drag the Vendor Sales Report file into the upper right dashboard panel.

4. Within the Edit Pane, type Product Vendor in the Title text box and click Apply.

5. Click Analysis folder in your samples repository (Steel Wheels) to display the list of available reports.

6. Click-and-drag the Top Five Lines by Territory Analyzer report into the upper left dashboard panel.

7. Within the Edit Pane, type Top Five Lines by Territory into the Title textbook and click Apply.
The title for this section will change to Top Five Lines by Territory.

8. Click on the Edit (pencil) icon to close the Edit View.
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9. Open Edit Mode and ensure the Top Five Lines by Territory pane is selected. Click on the Content Linking tab
and click the Enabled boxes so Years, Territory, and Line are all enabled. Click Apply. Save the dashboard.

10.Select the Product Vendor tab and click the {p} next to the Title box which currently holds Product Vendor.
The Product Vendor shows the two parameters that are applied to it.

11.Delete "& output-target parameter." You won't be needing that output presented in the title.

12.Choose the source of the Region parameter by selecting the source within the drop-down Source box. You have
now selected a content link.
The parameter appears next to the title. Exit Edit Mode by pressing the pencil icon if you want to see the user-
friendly name.

13.Select the Prompts option from the bottom panel. Ensure the Show Prompt Toolbar box is checked, so this will
appear at the top of the dashboard.

14.Add a new Prompt by clicking the Add icon.
The Prompt Dialog Box will appear.

15.Type Regions into the Name field. Ensure the Display name as control label box is checked.

16.Select the Control Type that you want to use. For the sample, the first option (Drop Down) is selected.

17.For the Type: drop-down menu, select Metadata List.
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18.Click the Select button
The Select Data Source dialogue box will appear.

19.Click on Orders and click OK.
The Query Editor dialogue box will appear.

20.Select Customer -> Territory and press the top right-facing arrow.
This will move Territory into the Selected Columns: panel. This means that Territory is now what is returned by the
query.

21.Click the middle green-facing arrow to add a condition on Territory.

22.Click on the drop-down Comparison option and select is not null.
This will move the Territory field to the Conditions: panel. This filters or restricts the data as you define it.

23.Click the bottom green-facing arrow to aggregate (organize) the Territory field. From the drop-down field you can
choose to order in ascending or descending order.
This will move the Territory into the Order By: panel.

24.Click the OK twice to exit to the Dashboard.
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25.Select the Product Vendor panel.

26.Under the Parameters tab, select Regions from the Source drop-down menu. Click Apply.
You have now linked this content to the prompt.

27.Click the edit (pencil) icon to exit Edit mode. You can save this dashboard by clicking the Save icon.
You can now dynamically apply the parameters to the Product Vendor panel. This will change the data and add the
parameter to the title.

Saving Your Dashboard
Follow the instructions below to save your dashboard:

1. In the toolbar, click the Save icon to open the dialog box.

2. In the File Name text box, type My Dashboard.

3. Save your file in the .../steel-wheels/dashboards directory. You can do this by double clicking the Steel
Wheels folder and the Dashboards folder.

4. Click Save.

Note:  To learn more about Dashboard features, see the Pentaho User Console Guide. Click Help ->
Documentation in the Pentaho User Console.

Editing Your Dashboard
In this exercise, you will edit a dashboard by adding a chart. Before you can add a chart you must select a data source
that contains the data you want to use. You must then define the data that will be displayed in the chart.

1. Double-click the Open File icon -> Steel-wheels -> Dashboards ->Regional Sales Performance file.
The dashboard opens.

2. Click the Edit icon in the Pentaho User Console toolbar.

3. In the Dashboard, choose a dashboard panel and click the Insert Content icon and select Chart from the drop-
down menu.
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A Warning Box Appears asking to Discard current content? Click OK. The Select a Data Source dialog box
appears.

4. Select Orders from the list of available choices. Click OK. The Orders data source contains the content you want to
display in your chart.
The Query Editor opens. The Query Editor allows you to retrieve dynamic data from a database for display in a
chart. Defining your query is the first step in ensuring that the correct data is selected.

5. Expand the Products category and select Product Line. Click the right-facing green arrow next to the Selected
Columns sub-window to place this option within the Selected Columns sub-window.

6. Expand the Orders category and select Total. Click the right-facing green arrow next to the Selected Columns sub-
window to place this option within the Selected Columns window.

7. Expand the Customer category and select Territory. Click the right-facing green arrow next to the Conditions sub-
window to place this option within the Conditions sub-window.

These are the constraints that filter what you are selecting.

8. In the Conditions sub-window, click on the drop-down menu within the Comparison column and select in.

9. In that same section, in the Value text box, type {Region}.

When you enclose a comparison name with curly braces, you are creating a parameter on that query.

10.In the Default text box, type APAC. Click on the Preview button.

When the chart renders (as seen in the preview), it displays data associated with APAC. APAC is the default value
of the parameter. That means users can change the query dynamically by replacing the default, "APAC," with a
different territory, (for example, EMEA), when the query runs. You can click Preview in the Query Editor to ensure
that the query you created is correct.

11.Click OK to exit the Query Editor.
The Chart Designer opens.

12.In the Chart Designer, under Type, select Pie Chart.

13.In the Data section, from the Series Column drop-down box, select Product Line.

14.Still in the Data section, from the Values Column drop-down box,, select Total.
The pie chart appears.

15.Click OK to exit the Chart Designer.
The pie chart appears in the dashboard panel.

16.Within the dashboard, in the gray sub-window at the bottom of the screen, ensure your current panel within the
dashboard is selected. Click the {p} button and {Region} will populate after the title.

17.Under the Parameters tab, You see the name Region with a drop-down box next to it. Select Territory from that
drop-down and click Apply.
When you exit Edit Mode, this will cause the applied parameter to appear after the title of the panel.

As you select a different territory, the individual reports and/or chart dynamically update. Because the Parameter value
was applied to the Product Performance cart, the applied parameter will appear after the name.
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Compatibility Matrix: List of Supported Products

32-bit Operating Systems

Both servers and workstations are covered in the table below; it's assumed that server software and engines will run
on server machines, and design tools will run on workstations. 32-bit operating systems in production environments are
becoming more rare. This list will grow shorter with time.

BA
Server/

Enterprise
Console

Data
Integration

Server

Reporting
Engine

Analysis
Engine

Data
Integration

Engine

Design
Studio

Report
Designer

Data
Integration

Metadata
Editor

Schema
Workbench

Aggregation
Designer

Windows
XP

Y Y Y Y Y Y Y Y Y Y Y

Windows
7

Y Y Y Y Y Y Y Y Y Y Y

Windows
2008
Server

Y Y Y Y Y N N N N N N

SUSE
Linux
Enterprise
Desktop/
Server
10

Y Y Y Y Y Y Y Y Y Y Y

Red Hat
Enterprise
Linux 5

Y Y Y Y Y Y Y Y Y Y Y

Ubuntu
Linux
10.04

Y Y Y Y Y Y Y Y Y Y Y

Solaris
10

Y Y Y Y Y Y Y Y Y N N

64-bit Operating Systems

Both servers and workstations are covered in the table below; it's assumed that server software and engines will run on
server machines, and design tools will run on workstations. All modern operating systems have 64-bit versions, and will
become the standard in the future. This list will grow longer with time.

BA
Server/

Enterprise
Console

Data
Integration

Server

Reporting
Engine

Analysis
Engine

Data
Integration

Engine

Design
Studio

Report
Designer

Data
Integration

Metadata
Editor

Schema
Workbench

Aggregation
Designer

Windows
7

Y Y Y Y Y Y Y Y Y Y Y

Windows
2008
Server

Y Y Y Y Y N N N N N N

Mac OS
X

Y Y Y Y Y Y Y Y Y Y Y

SUSE
Linux
Enterprise

Y Y Y Y Y Y Y Y Y Y Y
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BA
Server/

Enterprise
Console

Data
Integration

Server

Reporting
Engine

Analysis
Engine

Data
Integration

Engine

Design
Studio

Report
Designer

Data
Integration

Metadata
Editor

Schema
Workbench

Aggregation
Designer

Desktop/
Server
10

Red Hat
Enterprise
Linux 5

Y Y Y Y Y Y Y Y Y Y Y

Ubuntu
Linux
10.04

Y Y Y Y Y Y Y Y Y Y Y

Application Server

This refers to the Java application server used by Pentaho server applications and engines.

BA Server/
Enterprise
Console

Data Integration
Server

Reporting
Engine

Analysis Engine Data Integration
Engine

JBoss 5.1.x Y N Y Y Y

Tomcat 6.0.x Y Y Y Y Y

Repository

This refers to the solution data stored in the BA Server, DI Server, or in a PDI database repository. This has nothing to
do with data source support.

Note:  The DI Server has an integrated H2 solution database. Pentaho does not support using other solution
databases -- including non-Pentaho H2 database instances -- at this time.

BA Server/
Enterprise Console

Data Integration
Server

Data Integration
Engine

Data Integration

DB2 N N/A Y Y

H2 Database N Y Y Y

Ingres N N/A N Y

MySQL 5.x Y N/A Y Y

Oracle Y N/A Y Y

Postgres 8.x Y N/A Y Y

SQL Server N N/A Y Y

Data Sources

All databases that have a JDBC version 3 driver with full ANSI SQL support will work with the majority of
Pentaho Business Analytics. Pentaho Data Integration includes JDBC drivers for most if its supported data sources.
Pentaho Analysis has specific SQL dialect support for certain databases, but will work with others (possibly with poor
performance) through its generic JDBC dialect.
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BA
Server/

Enterprise
Console

Data
Integration

Server

Reporting
Engine

Analysis
Engine

Data
Integration

Engine

Design
Studio

Report
Designer

Data
Integration

Metadata
Editor

Schema
Workbench

Aggregation
Designer

Apache
Derby

Y Y Y Y Y Y Y Y Y Y Y

AS400 Y Y Y Y Y Y Y Y Y Y Y

Borland
InterBase

Y Y Y Y Y Y Y Y Y Y Y

Cache Y Y Y Y Y Y Y Y Y Y Y

DB2 Y Y Y Y Y Y Y Y Y Y Y

dBase
III, IV, 5

Y Y Y Y Y Y Y Y Y Y Y

EnterpriseDBY Y Y Y Y Y Y Y Y Y Y

Exasol N N N N Y N N Y N N N

Excel Y Y Y N/A Y Y N Y N N/A N/A

ExtenDB Y Y Y Y Y Y Y Y Y Y Y

Firebird
SQL

Y Y Y Y Y Y Y Y Y Y Y

Generic
(any
JDBC)

Y Y Y Y Y Y Y Y Y Y Y

Gupta
SQLBase

Y Y Y Y Y Y Y Y Y Y Y

H2 Y Y Y Y Y Y Y Y Y Y Y

HSQLDB
(formerly
Hypersonic)

Y Y Y Y Y Y Y Y Y Y Y

Informix Y Y Y Y Y Y Y Y Y Y Y

Ingres Y Y Y Y Y Y Y Y Y Y Y

LucidDB Y Y Y Y Y Y Y Y Y Y Y

MaxDB Y Y Y Y Y Y Y Y Y Y Y

Microsoft
Access

Y Y Y Y Y Y Y Y Y Y Y

MySQL
5.x

Y Y Y Y Y Y Y Y Y Y Y

Netezza Y Y Y Y Y Y Y Y Y Y Y

Oracle Y Y Y Y Y Y Y Y Y Y Y

OLAP
(Analysis)

Y Y Y N/A N Y Y N N N/A N/A

Pentaho
Metadata

Y Y Y N/A N Y Y N N/A N/A N/A

PlumTreeY Y Y Y Y Y Y Y Y Y Y

Postgres Y Y Y Y Y Y Y Y Y Y Y
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BA
Server/

Enterprise
Console

Data
Integration

Server

Reporting
Engine

Analysis
Engine

Data
Integration

Engine

Design
Studio

Report
Designer

Data
Integration

Metadata
Editor

Schema
Workbench

Aggregation
Designer

SAP N N N N N N N Y N N N

SAP
R/3

Y Y Y Y Y Y Y Y Y Y Y

SQL
Server
2005

Y Y Y Y Y Y Y Y Y Y Y

sqliteQ Y Y Y Y Y Y Y Y Y Y Y

Sybase Y Y Y Y Y Y Y Y Y Y Y

Teradata Y Y Y Y Y Y Y Y Y Y Y

Text
files

Y Y Y N/A Y Y N Y N N/A N/A

UniVerse
Database

Y Y Y Y Y Y Y Y Y Y Y

XML Y Y Y N/A Y Y N Y N N/A N/A

XML/A Y N Y N N Y N N N N N

Security

This refers to third-party authentication systems that can be integrated with the BA Server, DI Server, and Metadata
Editor.

BA Server/
Enterprise Console

Data Integration Server Metadata Editor

LDAP Y Y Y

Active Directory Y Y Y

RDBMS Y Y Y

CAS Y N Y

Integrated Windows
Authentication

Y N Y

Java Virtual Machines

This refers to the Java Runtime Environment (JRE) or Development Kit (JDK) required for running all Pentaho software.
Only the Sun/Oracle distribution is supported. Ports and derivatives of the standard Oracle distribution (such as
FreeBSD Diablo JDK) may work, but are not tested by Pentaho QA and therefore unsupported by Pentaho.

BA
Server/

Enterprise
Console

Data
Integration

Server

Reporting
Engine

Analysis
Engine

Data
Integration

Engine

Design
Studio

Report
Designer

Data
Integration

Metadata
Editor

Schema
Workbench

Aggregation
Designer

Sun
v 1.6
(6.0)

Y Y Y Y Y Y Y Y Y Y Y
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Web Browsers

A Web browser is required to use the Pentaho User Console (including Interactive Reporting, Analyzer, Dashboard
Designer, Community Dashboard Framework, Data Source Wizard, JPivot, and ad hoc reporting) and Pentaho
Enterprise Console. Report Designer requires a Web browser to preview reports exported to HTML format. If you use a
browser other than one of those listed here, you will very likely encounter some kind of problem.

BA Server/ Enterprise Console Report Designer

Internet Explorer 7, 8, 9 Y Y

Firefox 3.6, 9, 10 Y Y

Safari 5.x Y Y

Chrome Y Y

Legend

Y = Supported

N = Not Supported

N/A = Not Applicable
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Appendix: Troubleshooting Your Installation

The following tips may help you troubleshoot installation and other related issues.

Troubleshooting Your Installation
As stated previously, you must be able to assign ports, if necessary, during installation. It is recommended that you
contact your system or database administrator for help when you encounter port-related conflicts.

Below is the default port information:

MySQL Server Startup Port: 3306

Tomcat BA Server Startup Port: 8080

Tomcat Data Integration Server Startup Port: 9080

Enterprise Console Startup Port: 8088

Verifying Your Installation
After you have successfully installed Pentaho Business Analytics, this section steps you through verifying your
installation.

Note:  As you start and stop the consoles and other Pentaho components, you may see black command prompt
windows open or close. These windows display the scripts that run the Pentaho Business Analytics components.
You can minimize the command prompt windows so they do not clutter your desktop

Making sure the BA Server and MySQL have started

If you selected to launch the User Console or Enterprise Console, the installer automatically starts the BA Server,
Solution Repository, and Enterprise Console. You can check to see if the Pentaho BA Server and the MySQL database
that contains the Pentaho Solution Repository have started by launching “Services” from the Control Panel.

Go to Start -> Control Panel -> Administrative Tools -> Services. Under local Services scroll down to Pentaho BA
Server. In the image below, the Pentaho BA Server is started on Tomcat. The Pentaho Solution Repository (MySQL) is
also started.
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Note:  Right-click on the BA Server or Solution Repository in the Services window to start or stop them.
Alternatively, you can start the BA Server by navigating to Start -> Programs -> Pentaho Enterprise Edition  -
> Server Management -> Start BA Server. The MySQL database starts automatically when you log on to your
device.

Referencing Your Installation Summary

The installation summary automatically appears when you have completed an installation. It looks similar to the
example below. The installation summary provides you with information about what is installed on your computer. In this
example, all Pentaho Business Analytics components have been installed. The information in the summary helps the
support team know what has been installed.

Follow the instructions below before you call support to resolve an issue. The support staff must know what components
have been installed.

1. Navigate to the folder that contains Pentaho installation; for example, C:\Program Files\pentaho.

2. Locate and open the following file: installation-summary.txt.

3. Copy the contents of the file and send it, via email, to the support technician as instructed.

Resolving an Unable to Connect Error
If you followed the default installation instructions, the BA Server starts automatically at startup and remains available
until you shut your computer down, or, you manually stop the server. If the BA Server is not started, an Unable to
Connect  error will occur when you try to log onto the Pentaho User Console. This error may also occur if the URL to
the Pentaho User Console has been changed. The default URL is, http://localhost:8080/.

To correct the issue start the server. Go to Start -> Programs -> Pentaho Enterprise Edition -> Server Management
-> Start BA Server. If the problem persists, check the URL to make sure it has not changed.

Stopping the BA Server

To close the BA Server down after you log out of the Pentaho User Console, go to Start -> Programs -> Pentaho
Enterprise Edition -> Server Management -> Stop BA Server
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Resolving a License Not Found Error
Your Pentaho installation provides you with licenses to access all Pentaho Business Analytics components for 30
days. If, however, you attempt to use the software after 30 days or you uninstall and try to reinstall Pentaho Business
Analytics, a "License Not Found" error will occur. This is true even if the previous software was a trial version.

Contact your Pentaho Sales Representative or send an email to Support to reinstate licensing.

Resolving Port-Related Conflicts
As stated previously, you must be able to assign ports, if necessary, during installation. It is recommended that you
contact your system or database administrator for help when you encounter port-related conflicts.

Below is the default port information:

MySQL Server Startup Port: 3306

Tomcat BA Server Startup Port: 8080

Tomcat Data Integration Server Startup Port: 9080

Enterprise Console Startup Port: 8088

mailto:supportadmin@pentaho.com
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